Mathcad Tutorial

by Prof. Bern Kohler, The Ohio State University
modified by Profs. D.S. Hamilton and E.E. Eyler, University of Connecticut

The goal of this tutorial is to help you to perform basic tasks using Mathcad as quickly as possible.
The text below describes some of the most commonly used features of the program--the ones you
are most likely to use in your work for Physics 258 and beyond. While you can learn a great deal
about Mathcad just by reading the contents of this file, you will find that nothing beats working with
the program yourself. This tutorial is a "live" Mathcad worksheet that encourages you to interact
with the Mathcad program, so don't just print the contents of this file. Instead, you should read
through this worksheet, taking time to try the tasks printed in bold text. Don't be afraid to
experiment!

Mathcad can do much more than is described in this simple tutorial. To learn more, consult the
program's help files (help menu) or copies of the printed manual (available in the 258 lab). In
particular, try the "Resource Center", which is accessible from the Help menu.

Mathcad creates worksheets that consist of text regions and math regions.

My Lab Report The text on the left is a "text region". This
comment is also a text region.

3+4=7 The simple equation on the left is a "math region”

Text regions

The text you are now reading is part of a text region. With time it should be easy for you to
distinguish math regions from text regions. Text regions are most often used to add comments to
worksheets, making it simpler to follow the calculations. You select a text region by left-clicking it
with the mouse. Once a text region is selected, a box with square handles will appear. Moving the
mouse over one of these handles changes the cursor to an arrow, indicating that you can resize
the box. Moving the mouse to any edge of the box around a text region will change the cursor to a
hand, indicating that you can click and drag the text box to a new location.

Use the mouse to select the text region above and resize it so it is no wider than
the horizontal line above "Text regions".

J The dashed, horizontal line below indicates a page break. | NOTE: Page breaks only
affect printing

To create a text region, click the mouse on a blank part of a worksheet. Select "Text Region"
from the Insert menu --or-- simply type the double quote character (") on the keyboard and then
begin typing the text you want to enter.



The text in a text region can be edited much like the text in a word processor. Note the vertical red
cursor in a selected region which indicates where text you type will be inserted. You can change the

font, font SiZ€, font color and style using buttons on the toolbars or by selecting commands in the
Format menu.

Remove the bold formatting from the text in this sentence.

The solid, vertical line at right —

indicates the right margin. The width of the
margins can be adjusted using "Page Setup"
in the File menu.

You can also enter Greek letter either by using the "Greek" pallet (View-Toolbars-Greek) or if you
place the insertion point directly to the right of the letter you want to turn into a Greek letter and
then type <ctrlI>G, the letter turnes into its Greek equivalant. The keysequence <ctrl>G toggles
between Greek and roman letters. (If you place the insertion point directly to the right of a Greek
letter and press <ctrI>G, the Greek letter will turn back into an equivalent roman letter.) Thus a p
turns into a «© , a d turns into a §, and a D becomes a A.

Type in below the fist three letters of the Greek alphabet (alpha, beta, and gamma)

There is a text region "hidden" off the right edge of the paper. Scroll the window
horizontally so you can find it, then move it between the horizontal lines below:

Math regions

Of course, the most powerful features of Mathcad have to do with math regions. The rest of this
tutorial will concentrate on these features.

Mathcad is a WYSIWYG (what-you-see-is-what-you-get) word processor for mathematics.
The following math regions are examples of simple formulas evaluated by Mathcad.

2-(3+4) =14 Type: 2%(3+4)=



23% — 27.984 Type: 2.3M=

V3

=1 Type: \25<space>/(4+1)=
4+1
%(2) +1 = 2847 Type: exp(2)/4<space>+1=
2
cos(%j =05 Type: cos(p<cntrl>G/4)"2=

The math regions in a Mathcad document are "live", meaning that they are recomputed as
information for any calculation is changed.

To see this, change the "4" in the first expression above to a "2" by clicking and editing.
Mathcad automatically recomputes the new result when you hit "enter" or click the mouse anywhere
else on the page. Note that editing mathematical expressions is a bit different than editing text, and
requires some getting used to. See the on-line help (Help menu) for more information about editing
math regions.

Replace 4 everywhere in the above expressions by 2, and observe how the results
change.

Another way to enter mathematical expressions is to use the "Calculator palette”. Bring up this
palette by clicking on the blue calculator icon on the "Math" toolbar.

You will next enter a simple math expression. Click anywhere in the white space below this
line, then follow the instructions in the next paragraph.

Instructions. Numbers can be entered by clicking on the appropriate buttons on the
arithmetic palette (blue calculator icon on tool bar), but it's simplest to use the
keyboard to enter them directly. Type 2. The red cross cursor disappears, and a box
is displayed containing the number 2. A blue line is visible immediately to the right of
the 2. This line is the insertion line for math expressions. Note also that the 2 is
underlined by a blue line. A useful rule to remember is that the underlined expression
to the left of the insertion line is used as the operand of the next operator you type.
An operator can be something like '+, or '-', or exponentiation. Now type '+' (or click
on the plus sign in the arithmetic palette), followed by a '3'. Now click on the
multiplication symbol in the palette (or type an asterisk *'). Type '5', then press the
equals button on the palette or type "=".

If you followed the above instrutions, your result should look like this:
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2+35=17

In the space below type the following sequence of keys: 2+3<space>*5=
[NOTE: <space> means to type the space bar once.

Typing a space "extends the selection”, underlining all of 2+3. Thus, 2+3 became the operand
for the next operator (multiplication) that you typed. Note how Mathcad automatically added
parentheses to indicate that the result of 2+3 is to be multiplied by 5. Using the space bar in

this way is a very useful skill that requires a little practice.

Variables

Mathcad can compute with variables that you define and modify. Recall above how you changed all
occurrences of "4" to "2" in the three expressions. Whenever you frequently modify input values it

may be more convenient to use variables. Like this:

a:=2 This line defines the value of variable "a".

2(3+4d) =10 using the variable "a".

The first line above tells Mathcad that the value of variable "a" is 2. This is how

you create variables in Mathcad. Just type the name and assign a value to it.
Notice the funny equals sign which looks like ":=". This is how Mathcad denotes the
assignment operator. The assignment operator assigns a value to a variable. Itis
different from the simple equals sign "=" which asks Mathcad to evaluate the
expression to the left of "=" and display the result. Just remember, use ":=" when
you are defining variables (or changing their values), and use "=" when you want
Mathcad to display a result. There are four different equals signs on the
"Evaluation" pallet.

This line and the following two math regions perform computations

Evaluation B

How to type ":=". (1) Type a colon (":") or (2) Click on the button with the ":=" symbol on the

Calculator or Evaluation palette.

Try redefining the value of "a" above, and watch how the calculated results
change.

Now move the line that defines "a" below this paragraph. Note how the calculations above
"break". The results disappear and "a" becomes highlighted in red text. Selecting any of the
broken expressions (left-click of mouse) reveals the trouble. An error message is displayed
indicating that "This variable or function is not defined above". This is because the ordering of
math regions on the page (worksheet) is significant. Mathcad evaluates in "reading order”, from left
to right and then top to bottom. Thus, variable assignments must occur to the left of or above
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statements that use the variable name. This is a very important point. Many problems with broken
worksheets can be fixed by carefully paying attention to where variable definitions are placed.

The following example should make this more clear:

myvar_1 := 10 Assignment statement. Note that variable names can use a
variety of characters. See program help for exact naming rules.

var .= 4 A second variable assignment

N\

var + myvar_1 = 14 Mathcad displays the result of adding the two variables.

var = 4 Display the value of "var".
var := 17 Now change the value of var
NWW

var + myvar_1 = 27 New result!

Here is a calculation that should start to give you a feeling for the power of a "math word processor"
like Mathcad:

Consider a relativistic electron moving with a velocity of 0.25 c¢ in a magnetic field of 1T. What
is the radius of curvature of its circular path?:

Go= 3.108 Type "3*1078" to enter the numerical value for the speed of light.
v:=.25-Cc
;= 1 The Lorentz factor "gamma" (entered the y from the GREEK toolbar)
y = 1.033
—19 —31
e := 1.602-10 m:=9.11-10 electron charge and mass
M N
B=1 magnetic field
Radius = m-y-v Mathcad calculates the radius (in meters). By changing the

values of "B" or "v" above, you can perform additional
calculations easily.
Radius = 4.405 x 10

Finally,note that variable names are case-sensitive. Thus,

radius = “radius" refers to a different (undefined) variable

Note about displaying very small numbers. Mathcad displays very small numbers as "0" when they
are less than a "zero tolerance". Any number greater than or equal to 10-Z will be displayed, where
Z is the zero tolerance (set using the Tolerance Tab accessed from the Format->Result menu).
Otherwise, the number will be displayed as zero. You should change the zero tolerance to an
appropriate value, if you wish to view the magnitude of a very small number.

Working with arrays



For many experiments it is simplest to work with data in arrays. This is often the case when
multiple measurements or readings are recorded in an experiment. Mathcad has a variety of tools
for working with arrays and matrices.

How to create an array (vector) variable

Select "Matrix..." from the Insert menu. An array (or vector) with n elements is just a matrix with n
rows and 1 column. Fill in the values you need in the dialog box and click OK. Try creating an
array named arrayl with 3 elements (3 rows, 1 column). Enter the values 5, 10, and 15 in the
placeholder boxes. You can move between the placeholders using the "Tab" key. The correct
result is shown below.
5
arrayl :=| 10

15

With Mathcad you can easily perform math on vectors.

array2 := 2-arrayl Multiply the elements in arrayl by two, and store the results in

a new array.
10
array2 = | 20 Display the results. This was done by typing array2=
30

You can also refer to individual elements of an array. This is done by subscripting.

array2g = 10 The first element of array2 is equal to 10. Note that the index of
the first element is 0 and not 1. This is because arrays in
Mathcad are numbered 0,1,2.... Such arrays are called
"zero-based".

To enter the above expression you type: array2[0=

The left bracket "[" is used to enter an array subscript.

Try to display the other elements of array2.

What happens when you try to display element 17 of array2? Click below

to read the error message.

array217 =

Reading data from a file into an array

The least powerful but most straightforward method is to use the clipboard. Open the data file using
a simple Windows utility program like "notepad” or "wordpad". Copy the data to the clipboard, then
type your array name, type the assignment operator, then paste the data from the clipboard (Edit
menu, or control-v). This creates a new vector containing the data. This cut-and-paste method can
also be used to create arrays or matrices from columns in Excel worksheets.
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X = This vector was created by pasting data from the clipboard.



Provided the columns are separated by tabs, then you can use this method to create
matrices.

1 2
2 , :
data := Contents of a two column data file were cut to the clipboard
3 10 and then pasted to create this two column matrix.
4 17

This will frequently be useful for dealing with x,y datafiles. You will frequently want to manipulate the
columns separately. Assuming the first column represents the x values, and the second column
contains y values, then we might do the following:

(0)

X := data To get the result on the left type x:data<ctrl-6>0
NOTE: <ctrl-6> means to hold the control key and press 6 at the same
time. Alternatively, you can select matrix column from the "Vector and
Matrix Palette".

y = data<l> Assign the second column of the matrix "data" to the vector y.

Try displaying the values of the vectors x and y to make sure you understand what is
going on.

Reading and writing data using Insert/Data menu commands

For more powerful and flexible data transfers to and from arrays, use the three commands
available from Mathcad's "Insert/Data" menu:

1. You can use "Insert/Data/Table" to create a data table, which defines the contents an array or
matrix whose name you select by typing it into the placeholder that appears to the left of the table.
The table can be populated by (1) direct typing, (2) using the clipboard, or (3) one-time reading
from a text or spreadsheet data file. You will find these tables very useful for handling the data
from your Physics 258 lab experiments. In older Mathcad versions, a less complete version of this
feature can be found under "Insert/Component/Input Table".

2. To associate an array permanently with a file name, so that the array will reflect changes to the
file when the spreadsheet is updated, use "Insert/Data/File Input". There is an even more flexible
version of this input command, under "Insert/Component/Data Input Wizard", which offers more
power at the cost of forcing you to type in more information.

3. Finally, to write an array to a text or spreadsheet file, use the corresponding output capability,
"Insert/Data/File Output".



Here's an example of an input data table that has been assigned to a 10 X 2 matrix named
"mydata”, containing some numbers that were typed into it.

mydata :=
0 1
0 0 0
1 2 4.1
2 4 15.5
3 6 35
4 8 63
5 12 142
6 14 197
7 16 255
8 20 390
9 0 0

Try typing additional data into the table. Note that if you tab beyond the present limits of
the matrix, additional rows or columns are added as necessary.

You can use the functions "rows(mydata)" and "cols(mydata)" to determine how many rows and
columns are contained in "mydata” if you need to index through it later. To delete rows or columns,
select a cell and then right-click on it, and choose "Insert Cells" or "Delete Cells".

To import a data file into the table, right-click on the upper left corner of the table, then select
"Import". A menu appears allowing you to select the file type and its location, after which the file
will be read into the data table. The same right-click menu also allows options for clipping and
pasting data to and from the table using the clipboard.

Create a simple two-column data file in a directory on your computer. Use the "Import"
capability to read the data into "mydata", then examine its contents.

Other data handling functions

When handling large amounts of data, you may sometimes find it preferable to use a binary
data storage format. In addition to the data import Wizard mentioned above, consider using the
functions READBIN and WRITEBIN, which can handle most any binary data type you are likely
to encounter.

You can also import objects such as drawings, charts, and sounds using the "Imsert/Object"
menu commands. There is even a limited capability for direct data acquisitions from National
Instruments data acquisition cards, using "Insert/Component/Data Acquisition”.

Finally, there are special commands that allow byte-level access to bitmapped images and to

sound files. For details consult the help menus for the functions READBMP, WRITEBMP,
READRGB, WRITERGB, READWAV, and WRITEWAV.

Making Graphs



A frequent task in Physics 258 is making graphs to display your results. While Mathcad can
generate a large number of 2D and 3D graphs, the only one you need to learn is the "X-Y Plot".
Select graph->X-Y plot from the Insert menu, or simply click on empty space and type the "@"
character. When you do you will see an empty template like the one below. Try it.

The placeholder on the bottom, horizontal axis is used to specify a vector of x values to plot. The
placeholder on the left axisis used to specify an equal length vector of y values. An example
should make this clearer. First let's define

xvals := First we create some x values.

A W N e

We can use this expression to generate an equal length array of y
values. Now we have a set of (x,y) pairs, suitable for graphing.

yvals := 2-xvals + 1

yvals = Display the resulting vector

© N o1 W

Now generate the graph.... We type "@" in whitespace below and then fill in the placeholders
with our two arrays:



10 T T
Voila. Mathcad graphs the result--a
8 — simple straight line.
yvals
4 — p—
l l
1 2 3 4
xvals
My Graph
10 T T
Try double-clicking the graph above to
bring up menus that allow you to change s |
the trace appearance, add a title, label the "
axes etc. Can you make the graph above E (o)
look like the one at right? HINT: Check g 61 |
"hide arguments" to hide the names of >
the mathcad variables and show only the ©
axis labels. a4 _
l l
1 2 3 4
X values

Finally note that graphs can be resized much like text regions. Try increasing the size of these
graphs.

That completes the tutorial. Hopefully you found this a useful way to quickly learn some of
the basic features of Mathcad.

To learn about some more advanced features, see the appendix below.

Appendix
A.1 Other features
Mathcad can do much more than can be described in this short tutorial. Consult the help

files for more information. To whet your appetite, here are a few examples of some of these
features with pointers to relevant documentation.

(1) You can define your own functions: see "functions, user-defined" in the help index

sgr(x) := x2 sqr(2) =4 sqr(10) = 100

f(t) = lo-exp(ﬁto) f(50) = 6.065 f(sqr(10)) = 3.679

10



(2) Mathcad can compute with units. see "units of measurement” in the help index

T := 298-K
MWV
n:= 1-mol
P:= 1-atm
-1 -1
R := 8.31441-J- K ~-mol
MV
n-RT . .
V.= 5 Solve for volume occupied by 1 mol of an ideal gas
V - 0.024 3 Mathcad handles all the unit conversions and displays the result
- m in cubic meters!
\V = 24.453L And we can ask for the volume in liters, by typing 'L'!

V = 1.492 x 10°in° Why not?

(3) Mathcad can use complex numbers without a change in notation
acos(17) = 3.525i

exp(1 + 2i) = —1.131 + 2.472i

(4) Mathcad can use range variables. see "range variables" in the help index
i=0.4 Expression on left was entered by typing: i:0;4

Display the result using i=

Al W[N] PO

Type: X[i:3,4,5,10,11

X
1)

==
REEER

Range variables can be used in iterative calculations such as
sums.

Z

3
-2

X

sum = 33 Display the result.
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Yj=ii+2 Range variables are frequently used for creating new vectors. 3
See the result at right -->

11
18

(4) Mathcad can do some symbolic math  see "symbolic calculation" in the help index

3

2 1.3 2 d—exp(zg)—>3~22-eZ
X +2~x+1dx—>§-x + X"+ X dz
N
1 1 1 1
Z i2—>—-(N+1)3——-(N+1)2+—-N+—
3 2 6 6
i=1

Other useful techniques:

A. Fast way to export x,y data

AiN:= 0..19

i
A)/(V{ =2+ 5%
xii= ()

Copy the columns to a matrix like this:

matj o = Xi matj. 1 = Yi

0 1

0 2 4

! 2.25 5.063 Type name of matrix followed by equals sign to
2 25 6.25 display it. Then click box at upper left, right click

mat =| 3 2.75 7.563 anywhere in table and choose copy. The data

7 3 5 can now be pasted to another program!

5 3.25| 10.563

6 3.5 12.25

7 3.75| 14.063
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B. To quickly plot a function y(x) vs. x you can type y@x, which will plot over a default range.

Example: myfen(z) = zz-sin(z)

100 T T T

Produced by typing
50 7 myfcn(z)@z and
then hitting return.

myfcn(z) O

_50 —

—100
-10 -5 0 5 10

C. You can also do fancier plots: Use the mouse to change perspective for this 3D

plot:
j:=1..50 j
J 1 104-sin(%)

k:=1..50 Mj k = 5
(k+ 10)
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